
ABSTRACT 

ARMES, ROBERT J. Aerodynamic Fuselage Design and Engine Integration for the Vampire 

Light Sport Aircraft. (Under the direction of Dr. Charles E. Hall Jr.) 

 

This paper covers the design of a new fuselage and the integration of the Rotax 912 ULS 

engine for the Vampire Light Sport Aircraft. The Vampire is a side-by-side two-seat pusher 

configuration currently owned by LSA America. The primary goals were to reduce the base 

drag of the existing prototype’s composite fuselage and to make provisions for adequate 

cooling of the engine. To accomplish these goals within the project’s scope and timeline, an 

analysis method using Fluent and the ANSYS 13 Workbench suite was developed. To 

evaluate drag, the fuselage and a 2-volume computational domain were modeled in 

SolidWorks. A mesh was generated in the Workbench mesh tool using manual element 

sizing controls, and the flow was simulated in Fluent using the Spalart-Allmaras turbulence 

model. The method was validated by comparing the drag results of a sphere to experimental 

data. Using the method in an iterative design process, a drop-in replacement fuselage for the 

Vampire was designed that reduces drag by 11.5% and as a result reduces the power required 

at a velocity of 120kts by 4.4hp. The new design was accomplished by modifying only the 

fuselage section aft of the firewall; this eases production of the new fuselage by only 

requiring the addition of plugs to the existing molds. After the external lines of the new 

fuselage were determined, the integration of the Rotax 912 ULS engine was performed. It 

was assumed that the stock frame and exhaust system as described in its installation manual 

would be used. In this application, the computational domain was modeled as a single 

volume and meshed in the Workbench mesh tool using a mix of automatic features and 

element size controls. The flow was simulated in Fluent using the Spalart-Allmaras 

turbulence model. Feedback from the flow visualization results allowed for ram air intake 

scoops and baffles to be designed such that cooling airflow reached critical engine 

components. 
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1 Introduction 

1.1  Brief History 

The Vampire is a small 2-seat pusher configuration aircraft that will be marketed in the 

Federal Aviation Administration’s (FAA) newest aircraft category of Light Sport Aircraft 

(LSA). This category was established to encompass simple small aircraft that would require 

less training for pilots to fly; these appeals to both new and experienced pilots as it is less 

costly and does not require a Class III medical certificate. Aircraft in this category must 

conform to the following FAA airworthiness criterion [1]: 

 Maximum takeoff weight (MTOW) not to exceed 1320 lbs. 

 Maximum allowable calibrated airspeed of 120 kts. 

 If powered, may only be a single reciprocating engine with a fixed-pitch or ground-

adjustable propeller. 

 Landing gear must be fixed. 

 Maximum stall speed of 45 kts in the clean configuration. 

 Maximum seating capacity of 2 including the pilot. 

Not to be confused with the original single-seat Vampire experimental aircraft produced by 

Sadler Aircraft Corporation in the early 1980’s, the current Vampire’s design instead drew 

heavily from a previous Sadler Aircraft design, the Piranha. It is characterized by twin tail-

booms, a large horizontal stabilizer, and spacious cabin with side-by-side seating for the pilot 

and passenger. The original 2008 Vampire prototype was also intended to have foldable 

wings for easy storage, as shown in Figure 1-1 on the next page. 
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Due to financial reasons and lack of investor funding, Sadler Aircraft Company sold the 

rights to the Vampire design in 2010 along with the prototype they had in their possession at 

the time [2]. It was purchased by LSA America, a North Carolina based company known for 

the Allegro Light Sport Aircraft. 

 

 

Figure 1-1: Original 2008 Vampire Prototype 

 

Figure 1-2: Second Vampire Prototype 
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1.2  Identified Areas for Improvement 

The second Vampire Prototype, which is currently in LSA America’s possession, has a few 

problems and design features that the company wishes to change to make the aircraft more 

marketable and easier to manufacture by means of sharing common components with the 

Allegro LSA and utilizing existing tooling in LSA America’s production line. The company 

approached the NC State Mechanical and Aerospace department for assistance in the re-

design of the Vampire aircraft. After an inspection of the prototype, the following areas were 

identified for improvement: 

The installed power-plant is a Jabiru 3300 6-cylinder reciprocating engine. Due to the 

positioning of the engine and length of the aft fuselage, a counter-balanced extension shaft is 

required to connect the propeller and spinner to the output shaft of the engine. For cooling, 

there are two side-mounted scoops that draw in ram air that is re-directed forwards over the 

cylinders and then down and out of the fuselage (Figure 1-3). The ribbed ducting and reversal 

of the cooling flow direction relative to the free stream introduces inefficiencies, and LSA 

America reports that the prototype has cooling issues when the engine is run at high throttle 

settings and at idle when stationary. Furthermore, the 6-cylinder engine may also be over-

sized for the LSA application which also means that the heavier engine subtracts useful 

payload capability from the LSA MTOW weight limit. To address these issues, LSA 

America requested that the engine be substituted with the Rotax 912 ULS – the same engine 

used in the Allegro. 
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Figure 1-3: Jabiru 3300 installed in Vampire Prototype 

Next, the aft section of the fuselage ends in a steep blunt face so that the fuselage lines can 

close and converge from the low wing to the high-mounted propeller (Figure 4). This 

geometric feature leads to highly separated airflow and adverse pressure gradients that cause 

more drag which in turn reduces fuel efficiency and performance. 

 

 

Figure 1-4: Blunt Fuselage Aft Section 
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The fuselage was manufactured using a chopped-fiberglass fiberglass layup, identical to a 

layup used in recreational boat construction. This type of composite layup is very heavy and 

overbuilt for an aircraft application. LSA America reported that due to the heavy fuselage, 

the 1320lbs MTOW limit was exceeded when the aircraft was fully loaded with two 

occupants on board. 

The fixed trailing link landing gear is fabricated from steel tubing and plates that are welded 

together. The material and gauge of the components are capable of handling structural loads 

of a much larger aircraft, and are therefore adding unnecessary weight to the Vampire. 

Lastly, LSA America expressed a desire to delete the folding wing feature. This would make 

the wings easier to manufacture if they were one-piece with a continuous spar. It would also 

eliminate any operator safety risks should pilots forget to secure the wings in the extended 

position before take-off. Such a feature change would require re-design of the wing structure. 

1.3  Project Scope 

It was the scope of this project to address the aerodynamic design of the fuselage and 

integration of the Rotax 912 ULS engine - including provisions for adequate cooling airflow. 

To re-shape the fuselage, Computational Fluid Dynamics (CFD) was used to more accurately 

capture the pressure effects of bluff geometry features and the low-wing configuration that 

normally would be made difficult and time consuming if done analytically. Computer-Aided 

Design (CAD) tools such as SolidWorks was used to perform the design and integration 

work as well as generate models that can be meshed for CFD simulations.  To address engine 

cooling airflow, CFD was used to model airflow internal to the engine compartment such that 

baffles can be designed and positioned to direct the airflow over critical cooling components. 

It was the goal of this thesis to develop and utilize a CFD method that allows for relatively 

fast and accurate analysis in the aforementioned applications that can be implemented by 

engineers with little to no experience in CFD. 
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2 Analysis Method 

LSA America provided the CAD files for the Vampire prototype. Since these files were 

generated by Sadler Aircraft in SolidWorks, it made sense to continue the design work in the 

same CAD suite. Several CFD packages were investigated for use with this project, including 

SolidWorks’ FlowSim and Fluent. It was decided that Fluent in the ANSYS 13 suite would 

be used since a full version of the SolidWorks FlowSim was not available to the university. 

Furthermore, Fluent is integrated into ANSYS Workbench which packages modeling, 

meshing, and post processing in a single interface. Being able to access all of these features 

from a single user interface streamlines the process and allows for faster turn-around times in 

iterative design processes. 

In CFD applications, the fluid volume around the part that is being analyzed must be 

modeled – not the part itself. It is common practice in CFD to model large volumes around 

the part in question because the effects of pressure and velocity can often reach into the far-

field of the domain. The computational domain is divided into smaller parts, called elements, 

in the meshing step. Typically, the smaller the elements, the more accurate the solution will 

be. This becomes an important principle to follow when meshing models for CFD 

simulation, as the elements must be small enough near the boundary layer to resolve it to get 

accurate drag and lift results. In summary, this means that for a CFD simulation to more 

accurately represent real-world flow, the computational domain must be large and the 

element size must be small; this also means that meshes with a very large number of 

elements is required. However, it was found during the method development phase of this 

project that the ANSYS Fluent student license limits the user to simulations with meshes of 

no more than about 1.5 million elements. This limit became difficult to work around, but the 

meshing methods detailed later in this section present a way to generate meshes using the 

ANSYS Workbench meshing tool to arrive at practical results. 
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2.1 CFD for External Fuselage Design 

It was found that the modeling step was made easier by the ANSYS Workbench Design 

Modeler tool where solid volumes could be subtracted from each other. These allowed the 

user to model both the part and the domain as separate solids. To obtain just the fluid 

volume, the user could then subtract the part volume from the domain once the part was 

properly positioned in the domain via an assembly. This process is detailed later in this 

section. The next step was to mesh the domain using the ANSYS Workbench meshing tool.  

Unlike traditional more commonly used CFD meshing tools, the Workbench mesher did not 

have as many fine control features to create a mesh that is ideal for CFD analysis. By using 

only a single-piece domain, it was difficult to mesh a model such that the elements near the 

part were small to capture the boundary layer and elements in the far-field were larger where 

pressure and velocity gradients are less severe. It was also very difficult to set-up the mesher 

to have a fine mesh in the wake of the part where separated flow and turbulence were 

expected to occur. However, if the domain was divided into multiple volumes in the 

SolidWorks assembly, the mesher could be commanded to generate different element sizes 

for different volumes of the domain once it was imported.  

Once a suitable mesh was generated, it was loaded into ANSYS Fluent and the simulation 

was set-up. The 1-equation Spalart-Allmaras (S-A) turbulence model was used for its faster 

computation times and reasonable results that were validated against experimental wind 

tunnel data. 

2.1.1 CAD Modeling 

In design applications, engineers usually model a part, such as a fuselage, as it would appear 

when fabricated. In CFD, however, the volume around the part must be modeled - like in a 

negative mold. Modeling for computational domains in CFD in CAD suites like SolidWorks 

is not as straight forward as one would think, and the extra time and effort it takes to use the 

mold tools or creating a separate model for CFD could easily discourage anyone wanting to 
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perform CFD analysis on their designs. However, if one looks beyond using only 

SolidWorks to model the computational domain, the ANSYS Workbench Design Modeler 

has a volume subtracting feature that makes this process simple. In addition to the part that 

the user wants to analyze in CFD, the user only needs to model a volume representing the 

computational domain. They can be imported to the Design Modeler as a SolidWorks 

assembly, and the volume of the part can be subtracted from the computational domain using 

the ‘Boolean Subtract’ command. Figure 2-1 depicts this process. Since fuselages are 

generally left-right symmetric, only half of the fluid domain was modeled for all cases in this 

project. This reduces the total computational domain volume and allows for a more refined 

mesh when working under an element limit. 

 

 

Figure 2-1: CAD Modeling Process for CFD Domain 

Figure 2-1 above depicts the original Vampire fuselage in the computational domain. Using 

this model, it was found to be very difficult to generate a mesh that was fine at the boundary 

layer, coarse in the far-field, and fine in the wake behind the fuselage. Instead, a two-volume 

approach shown in Figure 2-2 on the following page was used. The domain (blue) remained 

of the same dimension, but instead of being a single piece, a core-section (yellow) around the 

fuselage (red) extending to the outlet of the domain was added. In the meshing step, this 

allows for additional surfaces and volumes where element size controls can be implemented 

to refine the mesh in areas of interest. It is important to note that when modeling the two 
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volumes in CAD, their surfaces must be coincident in the assembly so that there are no gaps 

in the computational domain. 

 

 

Figure 2-2: Two-Part CFD Domain 

2.1.2 Meshing 

Once the computational domain was modeled and the fuselage part has been subtracted from 

the domain volume in the design modeler, the next step was to mesh the domain. This was 

done using the ANSYS Workbench mesh tool. Meshing consisted of two steps: the first step 

was to define named surface selections. Performing this step allowed Fluent to automatically 

detect which faces are inlets, outlets, symmetry planes, and walls. It also allows the user to 

select groups of faces, such as the fuselage, on which you can monitor drag and lift forces. 

The second step was creating element size controls on key surfaces. This step allowed 

control of the fineness of the mesh in important areas and also allowed for tailoring of the 

mesh so that it remained in the 1.5 million element limit of the ANSYS student license 

restriction. The following figures show an example of how named selections were designated 

on a mesh for an iteration of the re-designed Vampire fuselage. 
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Figure 2-3: Named Selections – Inlet (left) and Outlet (right) 

 

Figure 2-4: Named Selection – Symmetry (left) and Aircraft (right) 

 

Figure 2-5: Named Selection – Interface (left) and Farfield (right) 
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It was important that separate named selections for the interface surfaces on both the domain 

and the wake core were made. For example, an interface named ‘interface-domain’ was made 

on the domain body, and a separate selection named ‘interface-wake’ was made on the wake-

core body. This was required for the Fluent application to link the two bodies together in the 

mesh so they become one fluid volume. It also helped to name the surface selections using 

the naming convention given in the figure captions. The Fluent application automatically 

recognized the ‘inlet’, ‘outlet’, ‘symmetry’, and ‘interface’ keywords and automatically 

assigned the appropriate boundary conditions to them when the mesh was imported. This 

reduced the user workload and made the process faster. 

Using the aforementioned named selections, element size controls were implemented so that 

the desired mesh geometry was obtained. General sizing guidelines were developed using a 

trial-and-error approach where computational domain volume was balanced with element 

size on the various surfaces so that the mesh was fine enough to produce meaningful results 

while remaining under the 1.5 million element limit for the student license. Figure 2-6 on the 

following page depicts the final dimensions for the computational domain and the 

corresponding element size controls are listed in the following table. Note that the reference 

chord is 62”, the chord of the Vampire wing. Note the listed element sizing is in meters since 

the ANSYS Workbench mesh tool defaults to metric dimensioning. The percent-chord values 

are given so they can be used in other applications. 

 

Table 2-1: Element Size Control Values 

Surface 
Far-Field & 

Inlet 
Outlet Interface Aircraft 

Element Size (m) 0.35 0.15 0.07 0.015 

% Chord 22 9.5 4.4 0.95 
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Figure 2-6: Computational Domain Dimensions 

The final step before generating the mesh was to set-up the general mesh options. Most of the 

default settings for tetrahedral meshing were used with some exceptions. The options for 

advanced automatic sizing needed to be disabled since they could not function when manual 

sizing controls were used. The inflation options also needed to be manipulated. The Fluent 

application uses the term ‘inflation’ as the progressive scaling of cells in regions between 

elements of different sizes. It was found that the ‘Last Aspect Ratio’ setting for inflation 

provided the best transition from the fine mesh on the fuselage to the coarser setting on the 

wake-core and far-field faces. For reference and use in future applications, a step-by-step 

user guide is provided in Appendix A that walks through the process of meshing these 

computational domains in the Workbench mesh tool. 
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Figure 2-7: Vampire Fuselage CFD Mesh 

 

Figure 2-8: Vampire Fuselage CFD Mesh Close-Up 
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2.1.3 Fluent Set-Up 

In CFD, the governing equation set that is chosen for the analysis will have the greatest effect 

on the final results. Fluent offers multiple aerodynamic models to choose from - both viscous 

and inviscid. Among them are the 1-equation Spalart-Allmaras (S-A) turbulence model, and 

higher order ones such as the 4-equation transition Shear Stress Transport (SST) model. 

Typically, CFD simulations are very computationally expensive and can take hours or even 

days to converge on a solution. It also stands to reason that higher order models with larger 

governing equation sets would require more computation time. Since the goal of this project 

work was to develop and implement a method that was both easy and fast to use, the S-A 

model was chosen. The choice was reinforced by previous studies that compared various 

turbulence models in CFD applications where it was found that the S-A model better matches 

the experimental wind-tunnel data for low angles of attack and cases where larger 

percentages of the reference chord had attached flow [3]. The SST model, on the other hand 

gave results that better matched wind tunnel test data for higher angles of attack where a 

higher percentage of the reference chord had separated flow [3]. In the internal flow 

modeling phase of the project, a comparison of the S-A and SST models was performed on a 

simulation of engine compartment internal flow (Figure 2-9).  

 

 

Figure 2-9: Turbulence Model Comparison 
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It was reasonable to assume that if there were significant differences in the results of the two 

aerodynamic models, the highly turbulent flow in the engine compartment would set them 

apart. Examining the flow visualizations in Figure 2-9, the two results are very similar. The 

only differences emerge in the streamlines of the near-stagnant flow. However, the SST 

simulation required a run time of 64 hours while the S-A model converged in 21 hours. As 

such, the nearly identical velocity and pressure results made the S-A model the clear choice. 

In the set-up of the Fluent runs, most of the default settings for each option were used except 

for the mesh interfaces, boundary condition values, reference values, convergence criterion, 

and some solution controls. A detailed step-by-step process of the Fluent set-up is provided 

in Appendix A. It was important to define the mesh interface between the main 

computational domain and the wake-core bodies. If this step was not performed, then Fluent 

treated the wake-core as a solid body and the flow would completely bypass the aircraft 

model. As recommended in the ANSYS Fluent manual, the gradient solution method was set 

to ‘Green Gauss Node-Based’ as this was better suited to tetrahedral meshes [4]. Lift and 

drag monitors were set-up for the fuselage surfaces, the convergence criterion was set to 1e-6 

for all of the residuals, and the simulations were run for 3000 iterations. For fuselage analysis 

applications, Fluent reported typical computation times of about 20 hours.  

2.2 Fuselage CFD Method Validation 

To make sure that the mesh and Fluent solution set-up provided meaningful results, a 

benchmark case was run so that it could be compared to experimental wind tunnel data.  

Using the method outlined in Section 2.1, a sphere of 62” diameter was modeled. This size 

was selected so that the reference chords of both the Vampire wing and the sphere were 

equal, thus producing meshes with the same element sizes and densities. Furthermore, 

spheres are well-studied blunt bodies for which experimental drag coefficient data is readily 

available. The mesh for the sphere test case is shown in Figure 2-10 on the following page. 
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Figure 2-10: Sphere Drag Validation Mesh 

The element size controls listed in Table 2-1 were used to mesh the sphere, and there were 

about 1.22 million elements. The element count for the sphere case was lower than the 1.5 

million element limit due to geometric simplicity and lower surface area when compared to 

the Vampire fuselage. The free-stream conditions were set-up such that a Reynolds number 

of 1e6 was attained for standard atmospheric conditions. This particular Reynolds number 

was chosen as it was the upper limit of the experimental data being referenced in NACA-TN-

312 [5], which is the closest to the 6.78e6 Reynolds number that the Vampire wing 

experiences when cruising at 120kts in standard atmospheric conditions at sea-level. The 

reference values for the test case are given in the following table. 
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Table 2-2: Sphere Reference Values 

Parameter Value 

Reynolds Number 1e6 

Chord (ft) 5.167 

Area (ft
2
) 20.97 

Velocity (ft/s) 29.56 

Dynamic Pressure (psf) 1.035 

 

The Fluent simulation was set-up as described in Section 2.1 and 3000 solution iterations 

were commanded. The result was Cd = 0.121 and a Cl = 0. According to the NACA technical 

note, a sphere should have a Cd between 0.12 and 0.13, indicating that the Fluent CFD 

simulation and mesh provided an accurate and meaningful result. Thus, the mesh method and 

simulation set-up were validated. The following figures depict the rendering of the pressure 

and velocity results. Note that closer examination of the velocity rendering shows an 

asymmetric wake behind the sphere. This could likely be attributed to asymmetries in the 

tetrahedral mesh. 

 

 

Figure 2-11: Sphere Drag Validation Velocity Rendering 
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1  

Figure 2-12: Sphere Drag Validation Pressure Rendering 

2.3 CFD for Internal Flow Modeling 

The flow analysis within the engine compartment was more simple to mesh and set-up than 

the external fuselage flow models. Again, the computational domain and internal components 

were modeled in SolidWorks and arranged in an assembly. The ANSYS 13 Workbench 

Design Modeler tool was used to volume-subtract the internal components from the fluid 

volume before meshing in the Workbench mesh tool. This section provides more detail on 

the CAD modeling and meshing process for internal flow applications. 

2.3.1 CAD Modeling 

In the case of the Vampire, the engine compartment is defined by the volume contained 

within the fuselage aft of the firewall. This volume could be easily modeled using the full 

fuselage CAD models that were also used for the external fuselage drag analysis. In the 

SolidWorks part file, planes were defined along the firewall and aircraft centerline, and the 

excess volume was cut away from the fuselage as shown in the following figure. The 

fuselage skin thickness was not subtracted from the fluid volume and was omitted to simplify 
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the modeling process. This was also done because the skin thickness would not be known 

until detailed structural analysis is performed. 

 

 

Figure 2-13: Creating the Internal Flow Computational Domain 

In Figure 2-13, an example re-designed Vampire fuselage with a single roof-mounted intake 

scoop is shown. The next step was to arrange internal components such as the engine, wing 

structure, and baffles in a SolidWorks assembly as shown in Figure 2-16 on the left. The 

engine, driveshaft, and wing analogs were modeled as solids and positioned in the assembly 

in their respective locations. Note that the fluid volume model is also a solid, but it is shown 

to be transparent for clarity. The assembly was then exported to the ANSYS Workbench 

design modeler where the ‘boolean subtract’ feature was used to remove the volumes of the 

wing and engine from the computational domain as shown in Figure 2-14 on the next page. 
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Figure 2-14: Internal Flow Model Assembly 

2.3.2 Meshing 

Since the internal flow direction is mostly unknown in the engine compartment, all regions of 

the computational domain were treated equally. This greatly simplified the meshing process 

as this allowed use of the automatic meshing features in the Workbench mesh tool by 

defining a constant element size throughout the domain. Again, this was a trial-and-error 

process where the goal was to find an element size that provided the finest mesh while 

complying with the 1.5 million element limit. An example internal flow mesh is shown in 

Figure 2-15 where the element size was set to 0.0129m. Since the internal flow 

computational domain was not comprised of multiple volumes to control mesh inflation, 

defining the named selections was also simplified. For these cases, the only named selections 

required were ‘inlet’, ‘outlet’, and ‘symmetry’. All other faces were left unnamed so that 

Fluent automatically assigns the ‘wall’ boundary condition. Note that the Fluent simulation 

set-up and solver settings were identical to the method for external fuselage drag analysis. 
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Figure 2-15: Example Internal Flow Mesh 
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3 Fuselage Design 

Once the CFD drag analysis method was established and verified, the next phase of the 

project could begin: the re-design of the Vampire fuselage. As mentioned in Section 1, the 

existing Vampire prototype was designed for two-person side-by-side seating with a 

distinctive high visibility cockpit with gull wing doors. LSA America indicated that they 

favored the forward fuselage design as it gives the aircraft a good aesthetic profile that sets it 

apart from any other aircraft in the LSA category. Since the largest drag contributor was the 

aft face of the fuselage, it was decided that only the fuselage portion aft of the firewall would 

be modified. The goals for the re-design included the following: 

 Reduce fuselage drag. 

 Maintain overall aircraft aesthetics. 

 Ease the manufacturing process by designing the aft-fuselage such that the existing 

fuselage molds may be used with some modifications. 

 Make provisions for ample engine cooling. 

 Shorten the aft fuselage as much as is practically possible so that the engine 

extension shaft may be shortened or eliminated. 

First, the prototype fuselage was analyzed for drag using the CFD method outlined in section 

2. This set the baseline drag coefficient for which the new designs would be compared. Then 

new designs were created in SolidWorks and analyzed in Fluent. There were three designs 

that had a lower drag coefficient than the baseline, and one was selected based on the 

primary criteria listed above. 
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3.1 Establishing the Baseline 

When analyzing complex shapes for lift and drag, it is important to take into account any 

other geometric or design features that would affect the flow around the object, and thus the 

results. Since the Vampire is a low-wing aircraft, the low pressure region over the NACA 63-

218 wing with +4
o
 of incidence causes adverse pressure gradients that would affect flow 

separation on the aft fuselage. To account for this, it was decided that the fuselage models 

would incorporate the portion of the wing located between the two tail booms. The 11.8” x 

11.4” (30cm x 29 cm) spinner also acts to streamline the flow aft of the fuselage, so it was 

also incorporated to the solid model. For the purpose of the fuselage design and analysis, the 

ram air intakes were neglected. This was primarily because they would add complexity to the 

model where flow into and out of the fuselage would need to be accounted for to obtain 

accurate results. The following figure shows the major dimensions for the baseline fuselage: 

 

 

Figure 3-1: Baseline Fuselage Major Dimensions 
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Figures 2-10 and 2-11 show the mesh for the baseline fuselage which had 1.48 million 

elements. The following table lists the reference values used to set up the boundary and flow 

conditions for the Fluent analysis. Note that the analysis was performed at the maximum 

cruising speed for the Light Sport category of 120kts with zero degrees of fuselage pitch. 

Standard day seal-level pressure, density, and temperature were used. 

Table 3-1: Baseline Fuselage Reference Values 

Parameter Value 

Chord (ft) 5.167 

Area (ft
2
) 134.3 

Velocity (ft/s) 202.5 

Dynamic Pressure (fps) 47.99 

Reynolds Number 6.868e6 

 

 
 

 

Figure 3-2: Baseline Fuselage Velocity Contours (120kts) 
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Figure 3-3: Baseline Fuselage Pressure Contours (120kts) 

The Fluent solution gave a drag coefficient of Cd = 0.0150. A closer examination of Figure 3-

2 showed a large region of separation where the fuselage swept upwards. According to the 

Sadler CAD files, the angle on that face is about 50
o
, and this makes it a primary contributor 

of pressure drag on the aircraft. However, it should be noted that the effects of induced flow 

from the pusher-propeller are not being modeled although these effects generally help reduce 

adverse pressure gradients and thus reduce drag. On the other hand, modeling propeller 

effects is complicated in CFD set-ups, and it would add a level of complexity that is beyond 

the scope of this project. Instead, it was decided that all fuselage configurations for the 

Vampire project would be modeled without propeller effects was the results still give a 

relative drag comparison between configurations. 
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3.2 Dimension Constraints 

Before reconfiguration of the Vampire fuselage could begin, all of the design and 

dimensional constraints needed to be identified. These constraints were dictated by aspects 

such as internal structures, the engine, and fuselage wrapping around the desired seating 

layout. To reduce the pressure drag on the fuselage, the first goal was to reduce any up-sweep 

angles on the fuselage below 30
o
. According to Raymer [6], this should be the maximum 

angle that pusher-configuration fuselages have before encountering large flow separation 

problems. Reducing the overall length of the fuselage would also accomplish a reduction in 

skin-friction drag from having less wetted area. As such, it was necessary to determine how 

much the fuselage length could be reduced. The answer came from a closer inspection of the 

internal wing structure. 

 

 

Figure 3-4: Internal Wing Structure 
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As shown in Figure 3-4, the main spar mounted directly to the firewall, and as indicated by 

the red circle, the aft spar was located very close to the aft face of the fuselage. Because of 

this feature, the wing portion between the tail-booms had a shorter chord since the full 62” 

design chord protruded beyond the aft face of the fuselage. To work around this, the 

prototype was manufactured such that the airfoil profile was continued to the wing’s aft spar, 

and then a trailing edge wedge was installed from the aft spar up to the aft face of the 

fuselage as seen in the following figure. 

 

 

Figure 3-5: Wing Trailing Edge Detail 

The reduced chord for this section of the wing was 54.9”. Without the trailing edge wedge, 

the remaining chord was 47.8”. An option was considered where the trailing edge wedge 

would be omitted to simplify the manufacturing process. However, an investigation into the 

truncating an airfoil indicated that there would be a substantial drag penalty. The following 

equation from Hoerner [7] was used: 

    
    

√    
 (

  

  
)

 

 
           Eq. 3-1 

ΔCd is the change in drag coefficient, Cd,0 is the baseline drag coefficient for the airfoil, Δc is 

the percent change in chord due to the truncation, and cd is the baseline airfoil chord. Using 

XFoil, a well-known two-dimensional panel code for analyzing airfoils, the NACA 63-218 

has a zero-alpha drag coefficient of 0.0033 for a Reynolds number of 6.87e6. Substituting 
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this value along with the chord truncation of 22.8%, the equation indicated that the drag 

coefficient would increase by 0.32. This is a substantial increase in drag, and resulted in the 

decision to retain a trailing edge wedge. Further investigation was made to determine if there 

is a wedge angle that minimizes the drag of the modified airfoil section. However, 

experimental data indicated that the drag as a function of wedge angle monotonically 

increases from its minimum at zero degrees wedge angle - which is basically a flat plate [8]. 

It was decided that the trailing edge wedge would extend 4” aft of the aft spar which was also 

about 4” in height. In all, this sets the minimum fuselage length – not including the spinner – 

to 126”. 

Reducing the base area of a fuselage will also reduce the drag of a fuselage. This is typically 

accomplished by closing the fuselage to a point much the same way that an airfoil’s upper 

and lower camber converge on a trailing edge. Of course, there are several factors that limit 

the aft fuselage closure. For pusher configurations, there must be ample room to fit the 

engine, and in this particular case the fuselage must accommodate two people in a side-by-

side seating arrangement so the cross section must not be too narrow. As shown in Figure 3-

6, the cabin cross section could not be more tightly wrapped at the firewall without making 

the cabin cramped; thus, the cross-section at the firewall would not be modified in the re-

design. Additionally, the areas indicated in light blue represented the location of the fuel 

tanks. These tanks were sheeted and sealed portions of the wing with an open bay of width 

24.5” situated between them. So as to not expose this open area, the fuselage re-design was 

constrained to a minimum fuselage aft-face width of 24.5”.  
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Figure 3-6: Width Constraints 

The last geometric constraint on the re-design was the spinner. Since a new engine – the 

Rotax 912 ULS – was to be integrated into the new fuselage, the spinner dimensions needed 

to be updated. The new spinner was 9.84” in diameter and 9.44” in length (25cm x 24cm). 

3.3 New Design Configurations 

Using the constraints established in Section 3.2, new fuselage configurations were developed 

and tested in Fluent. To keep the modeling simple, a two-profile loft modeling approach was 

used. This involved truncating the original fuselage model at the firewall since the profile 

forward of the firewall was to remain unchanged from the prototype. A sketch plane was 

defined at the aft limit of fuselage, and the aft-most cross-sections were drawn on the plane. 

The loft could then be created by selecting the firewall face and extruding it to the aft-most 

cross-section. Since they were not present on the prototype fuselage, half-inch radius fillets 

were also added at the wing-fuselage interfaces to reduce interference drag. The new fuselage 

configurations all featured non-sloped blunt aft faces. Normally, this would contribute more 

base drag than the 50
o
 sloped face on the baseline fuselage. However, the blunt face was 

intended to be cut out of the fuselage so that it functioned as a large cooling outlet. The idea 

is that ram intake air would exit through this outlet, mix with the free-stream, and thus reduce 

pressure drag. 
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A total of three configurations, shown in Figure 3-7, were presented to LSA America where a 

final selection was made based on drag improvement, manufacturability, and aesthetics. 

Table 3-2 compiles the data comparing the configurations to the base line. This sub-section 

details the three configurations and their analysis. Note that equation 3-2 was used to 

calculate power required to propel the fuselage and partial wing section at a velocity of 

120kts: 

         
      

 

   
 

  

       
         Eq. 3-2 

Table 3-2: New Fuselage Configuration Comparison 

Parameter Baseline V1 V2 V3 

Cd 0.0150 0.0139 0.0134 0.0132 

Fuselage Length (in) 136 126 126 126 

Wetted Area (in
2
) 15,807 14,976 15,113 15,001 

Bluff Area (in
2
) 439 228 187 187 

Max Aft Closure Angle 

(deg) 
50 32 38 31 

% Drag Reduction -- 6.9 10.4 11.5 

Power Required (hp) 36.1 33.4 32.2 31.7 
 

 

 

Figure 3-7: New Fuselage Configuration Options 
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3.3.1 Version 1 

The configuration labeled ‘1’ in Figure 3-7 was the first iteration of the re-design. It 

conformed to the 126” length and 24.5” aft-width constraint without modifying the cross-

section at the fire-wall. The spinner was located in a high-mount position to provide 

additional propeller clearance and to keep the engine near the roof of the engine compartment 

to increase the effectiveness of a roof-mounted cooling intake scoop. The aft profile was 

shaped such that the lower section, which was constrained to the 24.5” minimum width, 

tangentially blended to the diameter of the spinner cone by means of an s-shaped curve. This 

is seen more clearly in the following figure. 

 

 

Figure 3-8: Rear and Side View for New Fuselage v1 

The reference values for the Fluent analysis were the same as those used in Table 3-1. The 

drag coefficient was 0.0139 representing a drag reduction of 6.9%. Although the bluff face 

area of this configuration was 228 in
2
, the drag reduction could be attributed to lower skin-

friction drag as a result of reduced wetted area. The reduction in the maximum closure angle 

also assisted in pressure recovery. The CFD renderings for this intermediate configuration 

can be found in Appendix B. 
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3.3.2 Version 2 

To further reduce the base drag, the outlet area needed to be reduced. According to Raymer, 

the outlet for engine cooling should be about 39% to 65% of the engine’s frontal area [9]. For 

the Rotax 912 ULS, this area is about 2 ft
2
 which placed the first iteration’s outlet area at 

79% engine frontal area.  Considering that pusher configurations have inherent cooling 

challenges, it was decided that the target outlet area would be at the upper range of 65%. An 

attempt was also made to close a portion of the aft fuselage to a point. This was done by 

‘pinching’ the loft below the spinner and extending it just low enough to accommodate a 

rectangular outlet of area 187 in
2
. This is depicted in Figure 3-9: 

 

 

Figure 3-9: Rear and Side View for New Fuselage v2 

References parameters from Table 3-1 were used for Fluent analysis, and the resulting drag 

coefficient was 0.0134 representing a drag reduction of 10.4% over baseline. This further 

improved drag value was attributed to the reduction of the engine compartment outlet area. 

The CFD renderings for this configuration are available in Appendix B. 

Although the drag reduction compared to the baseline was a significant improvement, there 

were some aspects of the second intermediate configuration that made it unsuitable as the 

final design. Firstly, the complete closure of the fuselage between the spinner and cooling 

outlet would complicate the manufacturing process; there is no clear location for a mold 

parting plane which means that when the composite layup was performed, it would be more 

difficult to remove the part once it was cured. Secondly, this configuration is not as 
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aesthetically pleasing and the geometric cues of the aft fuselage do not agree with the 

forward fuselage. This necessitated another re-configuration. 

3.3.3 Version 3 - Final 

The third and final configuration was influenced by the successes of the first and second 

intermediate designs. Instead of pinching the fuselage closed below the spinner, like in 

version 2, the target outlet area of 187 in
2
 would instead be accomplished by forming an s-

curve from the base of the aft profile upwards toward the spinner like in version 1. The result 

was the final configuration shown below and the CFD renderings of the simulation are given 

in the figures on the next page. 

 

 

Figure 3-10: Rear and Side View for Final Configuration 
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Figure 3-11: New Fuselage CFD Velocity Contours 

 

Figure 3-12: New Fuselage CFD Pressure Contours 



 

36 

The third configuration had a drag coefficient of 0.0132 – an 11.5% reduction when 

compared to the baseline. The drag was slightly lower than the second iteration despite 

having slightly more wetted area; this was likely due to having less interference drag in the 

absence of the aft fuselage closure. Comparing Figure 3-12 to Figure 3-3, the new fuselage 

shows improved pressure recovery over the baseline fuselage as evidenced by the pressure 

contours. In Figure 3-3, the contours extend outside of the wake-core, whereas in Figure 3-12 

the pressure recovers within the wake-core volume. Another feature to note is the stagnation 

region about the new fuselage’s cooling outlet. Since it was modeled as a closed solid, the 

simulation shows that this causes flow separation. However, despite the bluff aft face, the 

drag value for the new fuselage configuration is significantly lower than the baseline 

fuselage. This can be attributed to the improved streamlining of the aft fuselage along with a 

reduction in wetted area. It was important to keep in mind that the actual drag coefficient 

would decrease if cooling flow exiting the outlet were modeled. After consulting LSA 

America, it was agreed that the third iteration of the fuselage design was satisfactory for its 

aesthetics, significant drag reduction, and that it could be manufactured by adding plugs to 

the existing fuselage molds. 
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4 Engine Integration 

The positioning and cooling provisions for the engine could be performed after the new 

fuselage design was determined. As requested by LSA America, a Rotax 912 ULS, which is 

a 4-stroke 4-cyliner horizontally opposed small aircraft engine, was to be integrated into the 

Vampire airframe. The cylinder bodies were cooled by ram air, and it had radiators for 

cylinder head and oil cooling. LSA America was unable to provide dimensions and 

specifications for the engine mount and exhaust system that they use on the Allegro, so 

integration work with the Vampire was done assuming the stock Rotax engine mount and 

exhaust components as detailed in the engine’s installation manual [10]. All integration work 

was performed using a SolidWorks assembly and an engineering model of the Rotax 912 

ULS. For cooling, a primary intake scoop was designed and positioned on the roof of the 

fuselage to cool the engine and provide it with intake air for combustion. A secondary intake 

scoop was positioned on the belly of the fuselage to allow for some cooling of the exhaust 

system components and to assist in directing the ram air from the upper scoop out through 

the engine compartment’s outlet. Several baffles were required to direct the ram air to serve 

these functions. This section will detail the engine positioning, cooling intakes, and baffle 

designs. 

4.1 Engine Positioning 

To integrate the Rotax 912 ULS engine, an engineering CAD model, shown in Figure 4-1, 

was used [11]. Although this model did not include every wire and hose, it modeled the 

major components necessary for proper positioning and preliminary integration work. 

Locating the engine in the engine compartment was constrained by the position of the spinner 

and the dimensions of the engine suspension frame. The engine’s output shaft was aligned 

such that it was concentric with the spinner. The Rotax installation manual [10] provided 

coordinates for the stock engine suspension frame, and when modeled in SolidWorks, it 
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showed that there was about 1” of clearance between the air box and front face of the 

firewall. The location of the engine as installed in the new Vampire fuselage is depicted in 

Figure 4-2. 

 

Figure 4-1: Rotax 912 ULS Engine (right) and CAD Model (left) 

 

Figure 4-2: Engine Position in Engine Compartment 

Although the new fuselage is shorter than the prototype fuselage, the Rotax 912 ULS still 

required an extension shaft to reach the spinner. The extension shaft was 10.9” in length. It 

should be noted that the shaft length will need to be revised if spatial integration is re-iterated 

using the Allegro engine suspension frame as originally intended by LSA America. 
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Furthermore, the stock exhaust pipe was not long enough to vent exhaust outside the engine 

compartment. According to the spatial integration model, an extension of at least 2.75” 

would be required. 

4.2 Cooling Airflow 

The guidance of the interior cooling airflow followed a build-up process. Beginning with the 

engine bay fluid volume, the positioned engine, extension shaft, and internal wing structure, 

Fluent simulations were set-up using the method detailed in Section 2.3. Since the aircraft’s 

take-off run is the most cooling-critical phase of flight where high throttle settings and low 

airspeeds are experienced, the flow conditions at takeoff rotation were simulated. The Sadler 

Aircraft design files indicated that the Vampire had a stall speed in the clean (no flaps) 

configuration of 45 kts. Takeoff rotation speed is typically specified as 1.1 Vstall [12], and this 

gave the free-stream a velocity 49 kts (82.3 ft/s). 

The first step was to design an air intake scoop positioned on the roof of the fuselage. Scoops 

on the side of the fuselage and on its belly were also considered, but the side-mounted 

configuration was ruled out due to the width of the fuselage compared to the narrow engine. 

The belly-mounted location was ruled out to avoid Foreign Object Debris (FOD) ingestion. 

As a rule of thumb, the air intake area is sized to about 30% to 50% of the engine frontal area 

[9]. Initial intake scoop geometries aimed for the upper limit of 50%, which for the Rotax 

912 ULS is about 144in
2
. However, these intakes proved to be very large and they drastically 

affected the aesthetics of the aircraft and would likely negate any drag benefits gained from 

the new fuselage design. The final intake scoop had an area of about 69in
2
, which is about 

34% of the engine frontal area and was still within the bounds of the recommended intake 

sizing. No attempt at optimizing the air intake scoop was made. Instead, it was shaped to 

match the contours of the aircraft in a ‘looks-about-right’ fashion. The upper intake scoop is 

depicted in Figure 4-3. The intake scoop was about 22.9” wide and 3.25” in height. It 

extended 16” aft where it narrowed to a width of 13.5”. To mitigate interference drag, there 

was a 0.5” fillet along the sides and back of the scoop to blend it to the fuselage. 
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Figure 4-3: Upper Intake Scoop 

Before analysis of the internal flow could begin, it was necessary to determine the flow 

conditions at the intake scoop’s inlet. To do this, an external fuselage flow analysis without 

the intake scoop was performed at the rotation speed velocity of 82.3 ft/s using the method 

described in section 2.1. In results post-processing, the mid-plane velocity at the location of 

the intake scoop was sampled and found to be 78.3 ft/s. This was the velocity assigned to the 

inlet boundary condition for the internal flow analysis. Using the method in section 2.3, the 

internal flow mesh was generated with 1.48 million elements.  

In the un-baffled configuration, the intake air followed the contour of the roof of the engine 

compartment, was directed downward by the spinner back-plate, and exited via the outlet 

with some internal flow recirculation. This was a clear indication that a baffle was necessary 

to direct the intake airflow over the engine’s cylinders. To rectify this, a baffle was 

positioned at the root of the intake air scoop, and was angled down by 68
o
. With a length of 

8.3” at the mid-plane, it extended just behind the engine’s integrated gearbox as seen in 

Figure 4-4. 
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Figure 4-4: Upper Baffle Location 

Internal flow analysis with the inclusion of the upper baffle showed that the flow was 

directed over the engine’s cylinders. However, there was little to no flow over the exhaust 

components and the engine compartment outlet velocities were low. This indicated that most 

of the energy in the intake airflow was being dissipated inside the engine compartment – a 

phenomenon which increases the cooling drag of the aircraft. To induce low pressure in the 

lower portion of the engine bay, a small belly intake scoop was added with dimensions of 9” 

width, 2”  height, and 9” length. Half-inch radius fillets blended the scoop to the fuselage. 

Another benefit to this lower scoop was that it would act as a vent for the ‘chimney effect’ 

when the hot engine cools down after shutdown. Furthermore, FOD ingestion was not so 

much a concern for this scoop due to its smaller size.  

Using the external fuselage CFD analysis at rotation speed, the mid-plane velocity at the 

lower scoop inlet was sampled. It was found that the inlet velocity was 96.78 ft/s. After 

updating the internal flow model, the results showed that the airflow ran along the bottom of 

the fuselage and exited via the outlet after being diverted upwards by the aft spar. There was 

no observable effect on the airflow from the upper scoop. This prompted a re-configuration 

of the lower scoop; it was widened to span the 24.5” wing center bay and was shortened to a 

height of 1”. The final configuration of the lower scoop is seen in Figure 4-5: 
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Figure 4-5: Lower Intake Scoop 

Lower baffles were also positioned in the lower engine compartment for two purposes. 

Firstly, baffles extending the wing center section ribs to the floor of the engine compartment 

were placed as seen on the left in Figure 4-6. This served to reduce the fluid volume of the 

engine compartment to reduce random turbulent flow. Secondly, a baffle angled at 52
o
 that 

spanned the center bay was positioned as seen on the right in Figure 4-6 to direct the airflow 

from the lower scoop up toward the exhaust. This baffle had a length of 15.2” which allowed 

it to extend to the same plane as the lower limit of the engine compartment’s cooling outlet. 

 

 

Figure 4-6: Lower Baffles 
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The final internal flow analysis yielded favorable results as seen in Figure 4-7. The lower 

baffles and re-designed lower inlet scoop effectively directed airflow upwards to the exhaust 

components. The flow from the lower scoop also merged with the flow from the upper scoop 

aft of the engine such that the net flow was directed through the outlet with less turbulence 

than seen in previous internal flow analysis. It is important to note that if the engine position 

is updated in the future with the Allegro engine suspension frame and exhaust system, the 

angles and position of the baffles will need to be revised so that the cooling airflow is 

adequately directed over critical cooling components. 

 

 

Figure 4-7: Internal Flow Results for Final Baffle and Inlet Scoop Configuration 

The internal flow rendering of the intermediate design steps is provided in Appendix C. The 

geometry of the baffles and intake scoops is detailed in Appendix D. 
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5  Additional Considerations 

As described in the scope of this project, the aft portion of the Vampire fuselage was re-

designed to reduce drag and to house the Rotax 912 ULS engine. Analysis and design of 

components to direct cooling airflow over the engine’s critical cooling components was also 

performed. Before this project could be concluded, it was also within the scope to provide 

estimates of weight savings considering the change in installed engine, airflow baffles, and 

planned modification of the fuselage composite layup. Since the engine position was revised, 

an investigation into propeller clearance was also performed. Lastly, it was shown that the 

new fuselage design could be manufactured from the existing prototype fuselage molds by 

means of installing plugs. 

5.1 Full Assembly 

The new fuselage configuration was integrated to Sadler Aircraft’s full aircraft CAD 

assembly as seen in Figure 5-1. A dimensioned 3-view drawing of the new Vampire is 

available in Appendix E. 

 

Figure 5-1: New Fuselage Integrated with the Wing and Tail Components 



 

45 

The new fuselage was designed to be a direct drop-in replacement from the prototype 

fuselage where the wing structure is positioned and fastened to the fuselage firewall in the 

same location and manner. This reduces the necessary spatial integration and structural 

analysis required for future work on the Vampire.  

5.1.1 Propeller Clearance 

Integration of a new engine often requires a re-analysis of the aircraft’s performance so that a 

propeller may be chosen to give the aircraft its desired performance or to limit it so it remains 

in the bounds set by the LSA category. It was beyond the scope of this project to perform this 

analysis, but the full aircraft assembly could be used to determine how much clearance is 

available for propeller selection given the new engine positioning. 

 

 

Figure 5-2: Propeller Clearance 

According to Figure 5-2, a line drawn from the wheel contact point on the ground to the 

lowest point on the empennage gives a maximum tip-back angle of 14.2
o
. A radius drawn 

from the center of the spinner to this line shows that there is about 41” of clearance for a 

propeller. This is more clearance than the prototype Vampire since the Rotax 912 ULS is 

located higher and further forward than the Jabiru 3300. It is important to note that wheel 

deflation and landing gear deflection due to weight and landing loads were not accounted for 

in this measurement. Thus, a factor of safety in the stated clearance measurement should be 

used when selecting a propeller. 
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5.2 Estimated Weight Impacts 

One of the prototype Vampire’s problems was its MTOW as a result of a heavy fuselage 

composite layup schedule. Though not directly addressed in this project, an estimate of the 

potential weight savings could be made using the CAD models. This included the weight 

change caused by the cooling baffles, engine swap, and alteration of the composite layup 

schedule for the fuselage. In its current state, the prototype fuselage is fabricated using a 

chopped fiberglass layup common to boat manufacturing. These layups are typically much 

heavier than aircraft composites which often consist of layers of fiberglass sandwiching a 

foam or honeycomb core. It was reasonable to assume that once a detailed structural analysis 

for the new Vampire fuselage is performed, the resulting layup schedule would be similar to 

that of LSA America’s Allegro light sport aircraft. The company provided a composite panel 

from the Allegro’s fuselage and its composition is shown in the following figure: 

 

 

Figure 5-3: Allegro Composite Sandwich 

The composite layup consisted of five components totaling 0.242” in thickness: A foam core 

was sandwiched between two layers of fiberglass with the outer fiberglass layer being thicker 

than the inner layer. The outer-most layer was coated with gel-coat paint while the inner 

layer was coated with a moisture sealant. A sample of dimension 4.07”x2.61”x0.242” was 

cut from the supplied panel so that its density could be calculated. The sample had a mass of 

8.05e-4 slug, giving it a density of 0.541 slug/ft
3
 (279 kg/m

3
). For comparison, a sample 
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fiberglass layup was fabricated and measured to estimate the density of the prototype 

vampire’s fuselage composition.  The sample’s dimensions were 4.08”x2.65”x0.169” and it 

had a mass of 3.41e-3 slug. This resulted in a density of 3.22 slug/ft
3
 (1661 kg/m

3
). Both the 

new and prototype fuselages were assumed to have wall thicknesses equal to that of the 

0.242” thick Allegro panel sample that was provided. For simplicity, any firewalls, 

bulkheads, and other internal structures were omitted from this estimate. The resulting weight 

estimates were 246 lbs and 39.8 lbs for the prototype and new fuselage shells respectively. 

Absent from the prototype fuselage were baffles in the engine compartment. In the case of 

the new fuselage configuration, four baffles were required to properly direct cooling airflow 

over critical components. So as to not deflect or bend when redirecting high intake flow 

velocities, they needed to be fabricated from stiff but lightweight material. It was decided 

that the baffles were to be fabricated from 1/16” aluminum alloy sheeting and cut either by 

Computer Numeric Control (CNC) machining or by hand. Using the default SolidWorks 

density for 1060 alloy aluminum, the upper baffle weighed 1.04 lbs, the center-section rib 

extension baffles weighed 1.29 lbs each, and the lower angled baffle weighed 2.63 lbs. The 

combined weight of the baffles in the new fuselage was 6.25 lbs. 

The last component considered for weight impacts was the installed weight of the Rotax 912 

ULS engine. The prototype fuselage was designed to accommodate a Jabiru 3300 six-

cylinder boxer engine with an installed weight of 178 lbs [13]. The Rotax engine, on the 

other hand, had an installed weight of 140.6 lbs [14]. This shaved 37.4 lbs off the new 

configuration. Taking the difference of the total weight impacts from the two fuselages, a 

theoretical weight reduction of about 237 lbs can be realized. Table 5-1 summarizes the 

weight impacts from the aforementioned components. 
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Table 5-1: Weight Impact Summary 

Component Prototype Fuselage (lbs) New Fuselage (lbs) 

Fuselage Shell 246.0 39.79 

Baffles -- 6.25 

Engine 178 140.6 

Total: 424.0 186.6 

Δ -237.4 

 

The engine specifications, weight impact, and drag reduction were also used to estimate 

performance impacts. The power required for straight and level flight in standard sea level 

atmospheric conditions at 120 kts was calculated using Equation 3-1. The drag coefficient for 

the whole aircraft was assumed to be twice the drag coefficient of the fuselage and semi-

wing section used in the fuselage drag analysis. For the baseline fuselage, the estimated CD 

was 0.030. For the new fuselage, the drag coefficient was CD = 0.0264. Power available was 

assumed to be the maximum continuous power rating for the engines: 107hp and 95hp for the 

Jabiru [13] and Rotax [14] respectively. After accounting for an assumed propeller efficiency 

of 70%, the power available was reduced to 74.9hp and 66.5hp respectively.  

The power required for the baseline aircraft at 1320 lbs was 72.1hp which left enough excess 

power to attain an estimated maximum cruise speed of 121.5 kts. For the new fuselage 

configuration assuming a weight loss of 237 lbs and power required of 63.5hp from the drag 

reduction, the resulting estimated maximum speed was 121.9 kts. The performance summary 

is tabulated in Table 5-2 below. 

Table 5-2: Performance Estimate Summary 

Parameter Baseline Aircraft New Configuration 

CD 0.030 0.028 

Engine Power (hp) 107 95 

Power Available (hp) 74.9 66.5 

Power Required (hp) 73.1 63.5 

Weight (lbs) 1320 1083 

Estimated Vmax (kts) 121.5 121.9 
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5.3 Mold Plug 

LSA America planned to manufacture Vampire fuselages by performing composite lay-ups 

in the molds purchased from Sadler Aircraft. Since the new fuselage design is identical to the 

prototype forward of the firewall and the aft section is smaller in overall dimension, it is 

possible to modify the existing molds with plugs so that the new fuselage can made from 

these same molds. Figure 5-4 shows the prototype fuselage overlaid on the new fuselage, and 

Figure 5-5 shows the plug geometry after volume subtracting the two fuselages. 

 

 

Figure 5-4: New and Prototype Fuselage Aft Section Comparison 

 

Figure 5-5: CAD Model for Mold Plug 
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Details such as dimensions and the location of the parting plane of the existing mold were not 

provided, so it was not possible to define the parting plane line for the upper and lower half 

split of the plug. However, creating separate CAD models for the upper and lower plugs is a 

simple process once the parting plane is known. It is intended for the plug to be fabricated by 

routing excess material from a block of foam or medium to high density fiberboard. Once 

fabricated and finished, the plug can then be bonded to the existing molds. For reference, 

Table 5-2 contains dimensional and volume information to assist in sourcing material with 

which to fabricate, finish, and bond the plug. 

Table 5-3: Mold Plug Statistics 

Parameter Value 

Max. Length (in) 45.5 

Max. Width (in) 47.4 

Max. Height (in) 37.8 

Volume (in
3
) 10,202 

Outside Surface Area (in
2
) 4,344 

Inside Surface Area (in
2
) 3,629 
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6 Conclusion 

At the request of LSA America, a new fuselage configuration for the Vampire Light Sport 

Aircraft was designed. The primary goals were to reduce the base drag of the existing 

prototype’s fuselage and to integrate the Rotax 912 ULS engine. To accomplish these goals 

within the scope and timeline for this project, an analysis method using the ANSYS 13 

Workbench Fluent suite was developed to evaluate the aerodynamic performance of fuselage 

configurations and to visualize cooling airflow within the engine compartment. After an 

iterative design process, a drop-in replacement fuselage was designed that reduces drag by 

11.5% resulting in a reduction of power required at a velocity of 120kts by 4.4hp. The new 

design was accomplished by modifying only the fuselage section aft of the firewall; this 

facilitates production of the new fuselage by only requiring the addition of plugs to the 

existing molds.  

Provisions were also made to integrate the Rotax 912 ULS engine to the new Vampire 

fuselage. Since information on the desired engine suspension frame and exhaust system were 

unavailable, integration work was performed assuming that the stock frame and exhaust 

system as described in its installation manual would be used. The engine was positioned in 

the engine bay, and ram air intake scoops and airflow baffles were designed such that cooling 

airflow reached critical engine components. In this configuration, an output extension shaft 

of 10.9” was still required. It was beyond the scope of this project to perform detailed 

integration work, so the location of components such as the engine oil container, radiators, 

connecting hoses, and baffle fasteners were not defined. It is expected that future integration 

work will incorporate the Allegro LSA’s engine mount and exhaust system as originally 

requested by LSA America; this will require revision of the location, geometry, and 

orientation of the airflow baffles. However, the method and groundwork performed in this 

project will expedite and facilitate that process. 
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6.1 Future Work 

A possible avenue of future research would be to further develop the CFD application 

methods presented in this document. If unbounded by the limits of the ANSYS student 

license, there is potential for the external fuselage meshing and analysis method in Fluent to 

yield results that better align with experimental data. Furthermore, it may be of interest to 

expand this method such that external fuselage aerodynamics and internal flow are modeled 

in the same simulation; this would expand the results envelope to include more accurate 

intake flow conditions, cooling drag, and overall fuselage drag that accounts for ram-air 

intake and outlet flow. 

The design work presented in this paper represents only a fraction of what can be done to 

make the Vampire Light Sport Aircraft a successful and profitable product. Structural 

analysis, composite layup schedule design, performance and handling analysis, and detailed-

design and integration work are still required before the new fuselage configuration presented 

in this document can be implemented. The next step would be to structurally analyze the new 

fuselage and develop a new composite layup schedule. Using the Allegro’s composite 

structure as a benchmark, significant weight savings of 200 lbs or more can be realized if the 

chopped fiberglass layup is replaced with a foam-core composite sandwich. Further analysis 

would also be required to ensure that attachment of the wing and engine suspension frame to 

the firewall meets ANSI structural requirements for the LSA category. Replacement of the 

Jabiru 3300 with the Rotax 912 ULS engine necessitates a performance and handling re-

evaluation. The change in aerodynamics and mass of the new fuselage and its components 

has an effect on the dynamic modes of the aircraft, and they should be analyzed to ensure 

safe and satisfactory aircraft handling. Furthermore, work can be done to select a new 

propeller since the reduction in drag of the new fuselage may have expanded the Vampire’s 

performance capability beyond the LSA category limits. 
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6.2 Concluding Remarks 

Being a part of the Vampire re-design project has allowed me to further develop my aircraft 

design skills and multi-disciplinary perspective. Many aspects of performing design work on 

aircraft in the Light Sport category require that the engineer be mindful of multiple, and often 

conflicting, design goals that must be balanced to arrive at a successful design. This project 

also challenged my time management skills and ability to quickly learn to use new tools to 

develop methods to get the job done. 

The methods presented in this thesis for the aerodynamic drag analysis of fuselages and 

cooling airflow are not limited to LSA applications. If appropriately scaled, relatively fast 

evaluations of Unmanned Aerial Vehicles, general aviation aircraft, rockets, etc. can be 

performed by engineers who do not need to be experienced in CFD. It is my hope that the 

work presented in this document will be used by current and future engineers who are facing 

these sorts of design challenges. 
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Appendix A – Method User Guide 

This guide is intended for users to follow as step-by-step instructions, and is valid for 

ANSYS Workbench 13 and 14. The resulting mesh and analysis provides for coarse far-field 

results with a finer mesh and higher resolution near the fuselage or part and in the wake 

behind it. 

 

CAD Modeling 

1) Model your fuselage or part as a solid. 

2) Model the 2-volume computational domain as two separate solid parts. They should be 

coincident when placed in the assembly. Use the figure below as a size guide for the 

computational domain. 

 

 

Setting Up the Project 

1) Launch ANSYS Workbench 

2) Select ‘Fluid Flow (FLUENT)’ and drag it to the project schematic window 

3) Name and save the project. 
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Importing SolidWorks Geometry 

1) In the Project Schematic, Right Click ‘Geometry’ → ‘Edit Geometry…’ 

2) In the Design Modeler interface, ‘File’ → ‘Import External Geometry File…’, and 

select your SolidWorks assembly. 

3) In the tree outline, Right Click the ‘Import1’ label → ‘Generate’ 

4) Once the geometry has generated, click ‘Create’ → ‘Boolean’ 

 Set ‘Operation’ to ‘Subtract’ 

 Select your domain or wake-core as the ‘Target Body’ 

 Select the fuselage or part as the ‘Tool Body’ 

 Set ‘Preserve Tool Bodies’ to ‘No’ 

 Right Click the ‘Boolean1’ label → ‘Generate’ 

5) Expand the ‘Parts and Bodies’ label in the tree outline 

 Select each body and set ‘Fluid/Solid’ to ‘Fluid’ in the ‘Details of Body’ options 

menu. 

6) Close Design Modeler. The model will automatically update to the Workbench project. 

 

Meshing 

1) In the Project Schematic, Right Click ‘Mesh’ → ‘Edit…’ 

2) When opening the Mesher for the first time, you will be prompted to select general 

meshing options. Use the default tetrahedral meshing options and click ‘Apply’. 

3) In this step, you will create your named selections. Start by enabling face selection by 

clicking on the  icon in the upper toolbar. To select multiple faces, hold Ctrl and Left 

Click on the faces you wish to select. 

 Select the inlet face(s). Right Click → ‘Create Named Selection’ → Name the 

face(s) ‘inlet’ 

 Repeat the process for ‘outlet’ 

 Repeat the process for ‘symmetry’. Note that you will use the symmetry boundary 

condition if your part is left-right half symmetric. This requires that only half the 

compuational domain be modeled. If your part is not symmetric, skip this step. 

 Repeat the process for any selection of faces you wish to monitor lift, drag, or 

moments on. Name them anything other than the indicated keywords. 

 If meshing with two or more volumes, create ‘interface’ named selections. In the 

two-volume example given, both the coincident faces on the domain AND on the 

wake-core need to be given an ‘interface’ name. 

It is important to note that keywords such as ‘inlet’, ‘outlet’, ‘symmetry’ and ‘interface’ are 

automatically detected by Fluent. Naming them as such reduces your workload in the Fluent 

Set-Up steps. 
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4) In this step, you will create element size controls for the different named selections. Make 

sure that the ‘Mesh’ label is selected in the ‘Outline’ menu on the left side of the screen. 

With the  face selection option enabled, hold Ctrl and Left Click to select multiple 

faces. 

 Once the appropriate faces are selected, Right Click → ‘Insert’ → ‘Sizing’ 

 Under ‘Element Size’, specify the element size using the sizing chart below. 

Surface 
Far-Field & 

Inlet 
Outlet Interfaces Aircraft/Part 

% Ref. Chord 22 9.5 4.4 0.95 

 

5) Now it is time to set up the general and automatic mesh options. Select ‘Mesh’ in the 

outline window. Expand the ‘Sizing’ label. 

 Set ‘Used Advanced Sizing’ to ‘Off’ 

 Set ‘Relevance Center’ to ‘Fine’ 

 Set ‘Smoothing’ to ‘High’ 

 Set ‘Transition’ to ‘Slow’ 

6) Expand the ‘Inflation’ label. 

 Set ‘Inflation Option’ to ‘Last Aspect Ratio’ 

 Set ‘First Layer Height’ to the size of your smallest defined element from Step 4 

 Set ‘Maximum Layers’ to 1000 

7) In the upper toolbar, click ‘Mesh’ → ‘Generate Mesh’ 

8) Inspect the mesh to make sure it is under 1.5 million elements in the ‘Statistics’ tab. If it 

is satisfactory, click ‘Update’. Once this is finished, close the Mesher tool. 

 

Fluent Set-Up 

1) In the Workbench project schematic, Right Click ‘Setup’ → ‘Edit…’ 

2) When the launch menu appears, leave all settings as default and click ‘Ok’ 

3) Once Fluent Launches, Click on the ‘General’ label in the ‘Problem Setup’ tree. 

 Click ‘Units…’, and set-up the unit system you are using. Click ‘Close’ when 

done. 

4) Click on the ‘Models’ label in the ‘Problem Setup’ tree. 

 Select the aerodynamics model (third option down), Click ‘Edit…’ 

 Select ‘Spalart-Allmaras’, and leave the settings at their default values. 

 Click ‘OK’ 

5) Click on the ‘Materials’ label in the ‘Problem Setup’ tree 

 Select ‘Air’ 
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6) Click on ‘Boundary Conditions’ in the ‘Problem Setup’ tree 

 Set appropriate pressure and velocity conditions for the ‘inlet’ 

 Check that appropriate boundary conditions for the other named selections have 

been assigned. 

7) Click on ‘Mesh Interfaces’ in the ‘Problem Setup’ tree 

 Click ‘Create/Edit’ 

 Name the interface in the ‘Mesh Interface’ field 

 Select the two interfaces, and click ‘Create’ 

8) Edit the values in the ‘Reference Values’ label in the ‘Problem Setup’ tree 

9) Click on the ‘Solution Methods’ label in the ‘Problem Setup’ tree 

 Change the option under ‘Gradient’ to ‘Green-Gauss Node Based’ 

10)  Click on the ‘Monitors’ label in the ‘Problem Setup’ tree 

 Select ‘Residuals’ and Click ‘Edit…’. Set your desired convergence criterion and 

reporting intervals. Click ‘Ok’ when done. 

 Set up any lift, drag, and moment monitors in the same manner. 

11)  Click on the ‘General’ label in the ‘Problem Setup’ tree 

 Click ‘Check’. This checks the mesh and interfaces. If no errors occur, proceed 

with the next steps. 

12)  Click on the ‘Solution Initialization’ label in the ‘Problem Setup’ tree. 

 Select ‘Hybrid Initialization’ and click ‘Initialize’. If the Hybrid initialization 

fails, proceed to the next sub-step. If it is successful, skip to step 12. 

 Select ‘Standard Initialization’. Input the inlet flow conditions in the fields and 

click ‘Initialize’. 

13)  Click on the ‘Run Calculation’ label in the ‘Problem Setup’ tree. 

 Click ‘Check Case…’ and examine the report for any major errors or steps 

missed. If there are none, proceed to the next steps. 

 Input desired number of iterations in the ‘Number of Iterations’ field. 

 Click ‘Calculate’ 

Now your Fluent simulation should be running. Observe and residuals and lift/drag/moment 

monitors if any to make sure the simulation is converging in an expected direction. Once the 

simulation is done, it is ready for post-processing and results rendering. 
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Appendix B – Intermediate CFD Results 

 

 

Figure 0-1: New Fuselage v1 Velocity Results 

 

Figure 0-2: New Fuselage v1 Pressure Results 
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Figure 0-3: New Fuselage v2 Velocity Results 

 

Figure 0-4: New Fuselage v2 Pressure Results 
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Appendix C – Intermediate Internal Flow CFD Results 

 

 

Figure 0-5: Un-Baffled Internal Flow 

 

Figure 0-6: Internal Flow with Single Upper Baffle 
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Figure 0-7: Internal Flow with Upper Baffle and Small Lower Inlet 

 

Figure 0-8: Mesh for Final Internal Flow Simulation 
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Appendix D – Cooling Component Geometry 

UPPER INTAKE SCOOP 

Units in inches unless otherwise specified. 

 

 

 

Table 0-1: Upper Intake Scoop Statistics 

Parameter Value 

Outer Surface Area (in
2
) 372.8 

Inner Surface Area (in
2
) 370.5 

Fillet Radius (in) 0.5 
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LOWER INTAKE SCOOP 

Units in inches unless otherwise specified. 

 

 
 

Table 0-2: Lower Intake Scoop Statistics 

Parameter Value 

Outer Surface Area (in
2
) 214.8 

Inner Surface Area (in
2
) 207.9 

Fillet Radius (in) 0.5 

 



 

67 

UPPER BAFFLE 

Units in inches unless otherwise specified. Dimensioned points are provided so a spline fit 

may be re-created to generate the baffle dimensions. 

 

 

Area: 170.6in
2 

LOWER BAFFLE 

Units in inches unless otherwise specified. 

 

 

Area: 432.3 in
2 
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MID-RIB EXTENSIONS 

Units in inches unless otherwise specified. Dimensioned points are provided so a spline fit 

may be re-created to generate the baffle dimensions. 

 

 

 

 

 

Area: 210.7 in
2
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Appendix E – New Vampire 3-View 

 

 

Units in inches unless otherwise specified. Measurements taken from CAD assembly 

provided by Sadler Aircraft. 


